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The Index contains a list of all Help topics available for dIndex. For information on how to use Help, press 
F1 or choose How to Use Help from the Help menu.



dIndex's Command line

While dIndex may be started using the normal Window's methods (ie. double clicking on its 
icon in Program Manager, or on the .EXE file name in File Manager), dIndex may also be 
started using a command line issued from Program Manager's RUN command or any 
comparable application launcher.

The command line format is

[path]DINDEX.EXE parameters

where parameters may be any or all of the following (separated by spaces - in any order)

[path]filename.DLX for a database file to be loaded automatically
[path]filename.DLS for a style sheet to be loaded automatically
/P forms/labels for the entire database will be printed immediately.

Note that full pathnames for files must be provided if they are not in the application's 
directory or on the Window's path. Also if a Style sheet name is not specified then the 
default style will be used.



Menu Reference
File Menu
Edit Menu
Display Menu
Search Menu
Options Menu
Select Menu
Record#
Page#



Dialogs
Background Settings dialog
Barcode editor dialog
Batch edit dialog
Batch print dialog
Change printer dialog
Check box dialog
Editor dialog
Export dialog
Field block format editor dialog
Field block editor dialog
Font selection dialog
Form size dialog
Form size dialog
GoTo dialog
Grid editor dialog
Import dialog
Key strings editor dialog
Line size dialog
Load file dialog
Mark dialog
Print dialog
Printer setup dialog
Record index dialog
Replacement date dialog
Save file dialog
Search dialog
Search & Markdialog
Sequence dialog
Snap setting dialog



Database Procedures

Adding indexes
Adding records
Changing page
Closing dIndex
Copying a record
Creating a new field
Defining key strings
Deleting a database
Deleting a record
Editing an index field
Editing a field
Editing key strings
Exiting
Exporting multiple records
Finding a string
Image fields
Importing multiple records
Loading a database file
Marking records
Moving through a database
Opening a database file
Pasting a index entry from another application
Pasting a record
Viewing marked records



Form/Label design

Adding a barcode
Adding a date block
Adding a field block
Adding a sequence block
Adding a text block
Adding graphic elements
Setting an element's font
Cutting an element
Defining form sizes
Deleting an element
Importing a picture
Inserting a page
Loading a Style file
Moving an element
Resizing an element
Saving a Style file
Selecting form size



Form/Label editing
Changing an element's font
Changing form sizes
Copying an index block
Cutting an element
Deleting a Style
Deleting an element
Deleting a page
Editing a text block
Formatting a field
Importing a picture
Inserting a page
Moving an element
Pasting an element
Pasting a picture
Pasting text
Resizing an element
Saving a Style file
Selecting elements from the keyboard



Viewing and Printing
Batch printing
Hiding pictures and text blocks
Printing a form from another application
Printing forms
Rearranging windows
Speeding up screen redraws
Viewing form images



Edit Menu

The Edit menu includes commands that enable you to change the textual elements or contents of the 
current record, or add new records to the current database. 

For more information, select the Edit menu command name.

Cut Delete a selected element and copy to dIndex's clipboard
Copy Copy a selected element to dIndex's clipboard
Clear Deletes any currently selected item
Paste Block Copy any dIndex element on the clipboard onto the current form
Paste Form Copy the text on the clipboard to form a new record, ie an index field and 

associated field blocks
Paste Text only Copy the text on the clipboard to the currently selected text block
Paste Picture Copy the picture on the clipboard to the currently selected picture block
Add Add a new field or form element to the record style
Add Index Input new index field for a new record and add to the current database
Add records Input new records, including field blocks
Fill Fields Input new field blocks contents for currently displayed record
Edit Index Edit the index field of the currently displayed record
Edit Selection Edit the content of the currently selected item
Format Selection Format the currently selected item
Insert Page Insert new page after current page
Delete Page Delete current page



File Menu

The File menu includes commands that enable you to open and save database files, load and save 
styles, print forms, change the current printer or printer setup, or exit. 

For more information, select the File menu command name.

New Clear existing database from memory
Open Open a named database file
Import Import records from a file or the clipboard
Export Export records to a file or the clipboard
Save Save the current database file
Save As Save the current database to a named file
New Style Clear the existing style information from memory
Load Style Load a style from a style file
Save Style Save the current style to a file
Print Print forms on current printer
Printer Setup Check or modify current printer setup
Batch Editor Edit a batch printing file (Professional Plus version only)
Batch Print Start a batch printing operation (Professional Plus version only)
Change Printer Change the current printer
Exit Windows Close all open applications, exit Windows and return to DOS
Exit Close dIndex



Display Menu

The Display menu includes commands that enable you to change the appearance of dIndex's display or 
restrict which forms or elements are displayed.

Some commands are available only in printer display mode.

For more information, select the Display menu command name.

List Display index field of all current found list records
Normal Display current record fields
Printer view Display current form image at normal size
Page view Display form image to fit on screen
Maximize view Display form image at enlarged size
First Page Display first page of current form
Next Page Display next page of current form
Previous Page Display previous page of current form
Last Page Display last page of current form
Show Index Display the Database index dialog box
Show Outlines Display element outline
Fit fields Fit fields into space provided
Show Marked only Shows only records which have been marked
Field block names Shows names of field blocks rather than contents
Show All Show all elements on the current form image
Hide All Hide all elements other than the index field on the current form
Hide Pictures Hide all pictures on the current form image
Hide Text block Hide all text blocks on the current form image
Large fonts Show form image using readable or right-size fonts.
Set Background Set the background and page outline colours
Tile Rearrange all open application windows on the display screen



Search Menuitem

The Search menu invokes.the dIndex Search dialog.which permits records of the database to be retrieved
based on the presence of a specified search string in one or more fields of the record.



Add Submenu

The Add submenu includes commands that enable you to add elements to the current form image.

For more information, select the Add menu command name.

Field block Add a field block to the current form
Index Add a copy of the index field block to the current form
Barcode Add a barcode to the current form
Text block Add a text block to the current form
Picture Add a picture block to the current form
Check box Add a check box to the current form
Date Add a date block to the current form
Sequence Add a sequence block to the current form
Box Add a box to the current form
Grid Add a grid block to the current form
Vertical line Add a vertical line to the current form
Horizontal line Add a horizontal to the current form
New page Add a new page to the current form



Options Menu

The Options menu shows options which depend on the current display mode.

For more information, select the Options menu command name.

In printer view mode the Options menu includes commands that enable you to specify types and sizes for 
forms, fonts or lines, and to save the default style

Selection fonts Specify the font to be used for the currently selected element
Field font Specify the font to be used for the field block elements
Line size Specify the line thickness to be used for lines in the currently selected element
Box lines Specify the line thickness to be used for boxes in the currently selected element
Form sizes Specify the size of the current form image
Field blocks mode Toggles field blocks mode on and off
Reorder Field blocks Reorder named field blocks 
Key strings Create and edit Key strings
Set ^ to date Define replacement date
Snap setting Set Snap on or off, and set the snap grid size
Save defaults Save the current style as dIndex's default

In normal view mode the Options menu includes commands that enable you to specify format of the 
display, permits the field blocks to be reordered and the key strings to be edited.

Multiline fields Display field blocks as single or multiple lines
Reorder Field blocks Reorder named field blocks 
Key strings Create and edit Key strings



Select Menu

The Select menu includes commands that enable you to select specific records or specific form elements

For more information, select the Select menu command name.

Next Display next record in list
Previous Display previous record in list
First Display first record in list
Last Display last record in list
Search Search for a specific text string
Repeat search Repeat search using previous search text
GoTo Display a specific record
Mark Mark records
Field block Select a field on the form image or display
Barcode Select a barcode on the form image
Index Select an index item on the form image or display
Text block Select a text block item on the form image
Picture Select a picture item on the form image
Vert line Select a vertical line on the form image
Horz line Select a horizontal line on the form image
Box Select a box on the form image
Grid Select a grid on the form image
Date Select a date item on the form image
Sequence label Select a sequence no. item on the form image
Select Again Select the last element which was selected



Glossary

index
barcode
box
click
clipboard
checkbox
date block
double click
drag
field block
grid
horizontal line
key strings
mark
picture block
select
sequence label block
snapping
text block
vertical line



File New Command

Causes the current Database to be removed from memory. 

The current form style and size are not changed.



File Open Command

Displays the Open file dialog box, which allows the user to select a database file for opening. The dialog 
box shows the list of database file names available in the current directory, using the default 
extension .DLX. 

An alternative drive and/or path may be selected from the drive and directory combo-boxes.



File Import Command

Displays the Import Database dialog box which permits the user to select the line, field and record 
separators which should be employed when importing a database. 

Imported databases may contain field block fillings.

The Import Database dialog box also permits the user to select the source of the import, which may be a 
disk file or the Windows clipboard, by clicking on the relevant radio button. The clipboard may be selected
as the source of import only when the clipboard contains text-format data.

If import is to be from the clipboard, then clicking on OK will initiate the import. If importation is to be from 
a disk file, then clicking on OK causes the Open file dialog box to be displayed



File Export Command

Displays the Export Database dialog box which permits the user to select the line, field and record 
separators which should be employed when exporting the records of a database.

The Export Database dialog box also permits the user to select the destination of the export, which may 
be a disk file or the Windows clipboard, by clicking on the relevant radio button. 

If export is to the clipboard, then clicking on OK will initiate the export. If export is to a disk file, then 
clicking on OK causes the Save file dialog box to be displayed



File Save Command

Saves the current Database into the currently named Record file. The name of the current Database file is
shown in the main window's title bar.

If no current database file name exists, Save behaves as Save As.



File Save As Command

Displays the Save file dialog box, which allows the user to name a file for saving the current Database. 

An alternative drive and/or path may be selected from the drive and directory combo-boxes.

Database files are automatically saved with the extension .DLX unless an alternative extension is 
explicitly included in the filename.



File New Style Command

Causes the elements and fonts of the current style to be deleted, with the exception of the index field 
block characteristics - which may be modified by selecting the SELECTION FONT item of the OPTIONS 
menu. 



File Load Style Command

Displays the Open Style file dialog box, which allows the user to select a Style file for loading. The dialog 
box shows the list of style file names available in the current directory, using the extension .DLS. 

An alternative drive and/or path may be selected from the drive and directory combo-boxes.

If a stylename is selected and OK clicked or return pressed, then the style sheet is loaded and the 
elements contained in the style will be displayed.

Note that when a new style is loaded the display of all elements is enabled.



File Save Style Command

Displays the Save Style file dialog box, which allows the user to name a file for saving the current Style 
parameters.

An alternative drive and/or path may be selected from the drive and directory combo-boxes.

Files are automatically saved with the extension .DLS unless an alternative extension is explicitly included
in the filename. 



File Print Command

The Print dialog box prompts for confirmation that the user wishes to print, and allows the user to change 
the number of copies of each form printed, the range of forms printed (current, range, marked or all) and 
the pages required for each form. It also provides an OPTIONS button for accessing the Print 
Options dialog which allows the setting of the left and top printer margins, the selection of 
centred or right feeding of the sheets into the printer, or modifications to the current printer 
setup.    

If OK is selected then the form image is printed for the currently selected range of recors on the currently 
selected printer using the current printer parameters (eg the port, quality and orientation). 

During printing a message box is visible on screen, allowing the user to cancel printing if required. 



Print Options dialog

The Print Options dialog box allows the setting of the left and top printer margins, the 
selection of centred or right feeding of the pages into the printer, or modifications to the 
current printer setup.    

The current printer is identified in the current printer box, along with the height and width of 
the physical page for which the printer is currently setup, and the corresponding printable 
dimensions allowed by the printer driver. 

The current form/label dimensions are also shown, although they cannot be changed from 
within the Print Options dialog box - see Form Sizes.

The X and Y margins boxes allow the user to provide positive or negative margins for the 
left-hand side (X) or the top (Y) of the printer's output page. In either case a positive number
will result in an increased margin size compared with any default value imposed by the 
printer driver. Note that if your printer is physically unable to print outside certain margin 
limits (eg. most laser printers cannot physically make an image at the edge of a full size 
page) then providing negative margins will cause the image to be cropped at the physical 
margin limit.

Some printers require the stationery to be fed to the printer either centred (some laser 
printers - such as the Apple LaserWriter - require such feeding for page sizes smaller than 
their maximum capacity) or right justified (again, some laser printers - such as the Hewlett 
Packard LaserJet series 1 - require right justified feeding for single sheets). Checking either 
the Centre feed or Right feed checkbox will cause dIndex to adjust its printing parameters 
accordingly.

Windows normally prints via a print spooler, which stores the output in a temporary disk file 
before printing. When printing large numbers of forms with an image which includes a 
picture it may be desirable to disable spooling in order to prevent the creation of relatively 
large temporary files. See your Windows documentation for details of how to do this on a 
long term basis. dIndex permits the temporary disabling of the spooler by checking the 
DISABLE SPOOLER checkbox in the Print Options dialog.

The Print Options dialog box contains a Printer Setup button which causes the currently 
selected printer setup dialog box to appear on the screen, and allows the user to change the
parameters for printing.

The dialog contains OK and Cancel buttons, which close the dialog. Note that if Printer Setup
has been called during the Print Options dialog, any changes in the setup for the specified 
printer are carried out when the Setup dialog is executed and cannot be cancelled by 
selecting cancel in the Print dialog.

For Label printing: 

While most printer drivers provide a choice of physical page sizes for the printer, it can 
happen that the label forms on which you wish to print do not match precisely with any of 
the page sizes offered. dIndex will allow a page offset distance to be added to the setup-
specified pagelength when a formfeed is generated. This allows non-standard stationery 
sizes to be used, or, more commonly, continuous rolls of labels for which the available page 
sizes are not an exact multiple of the repeating distance, to be used with continuous 
stationery printers.    Negative page offsets can be used, but if the offset causes any 
printable item to be positioned above the top of the driver's printable page area the item will
be cropped. The page offset facility is not operative when positive repeat height numbers 



have been specified (see Label sizes).



File Printer Setup Command

The Print Options dialog is displayed. This allows the setting of the left and top printer 
margins, the selection of centred or right feeding of the sheets into the printer, or 
modifications to the current printer setup.    

Pushing the OK button causes the dialog to close and any changes made within the dialog to
be stored in memory. However, it should be noted that such changes are only saved in the 
current style sheet if SAVE STYLE is subsequently selected.

Pushing the SETUP button causes the current printer Setup dialog box to appear on the screen. This 
allows the user to change the parameters for printing. The options available depend on the nature of the 
printer, but many will allow the selection of the orientation (landscape or portrait), the paper feed (manual 
or feeder), and the graphic image resolution. After the desired options have be chosen, they may be set 
as the current options by clicking on OK or pressing the enter key. Alternatively the Setup dialog may be 
cancelled by pressing the <esc> key or clicking on Cancel with the mouse pointer. 

Note that changing the printer setup and clicking on OK causes the changed setup to be used within 
dIndex but does not effect the default setup for that printer for other Windows applications.    
Consequently other Windows applications which subsequently access that printer will use continue to use
the default printer setup.    

dIndex will save the modified printer setup within the style sheet for the current form if this style sheet is 
saved after the printer setup dialog box has been displayed. 



File Change Printer Command

The Select Printer dialog box appears, showing a list of the printers available in the user's Windows 
environment.    The selection is made by moving the highlighted entry to the desired printer name, either 
by clicking on the name with the mouse pointer or by using the cursor keys to scroll the highlight. The 
highlighted printer name may then be selected as the current printer by either double clicking on the 
name, clicking on OK, or pressing the enter key. 



File Batch Editor Command

(Professional Plus version only)

The Batch Editor dialog box appears, showing a list of the current database records (Index fields) and a 
list the current batch commands. Facilities for opening existing batch files and saving edited files are also 
provided.



File Batch Print Command

(Professional Plus version only)

The Batch Print dialog box appears, showing the current options specified for batch printing: the currently 
selected printer, the current setting of the Replacement date, and the current batch file name (if any). 

Push buttons are provided to allow any of thee parameters to be changed before printing starts.



File Exit Windows Command

Once selected, the user will be prompted for confirmation and Windows will be asked to close down. The 
close down process involves all the currently open applications (including dIndex) receiving a close down 
message. Thus any application may display message boxes requesting permission to close or save data. 
dIndex will produce a message box if either a database or Form Style has been created or modified and 
the relevant information not already saved on disk. The box prompts the user with a request to save the 
information before dIndex terminates. Once all open application have closed down, Windows will 
terminate.



File Exit Command

Once selected, dIndex will terminate. If either a database or Form Style has been created or modified and
the relevant information not already saved on disk, the user will be prompted with a request to save the 
information before dIndex terminates.



Edit Cut Command

In Normal display mode the total content of the currently displayed record is cut - this includes the index 
field and all associated field blocks. If the current database contains further addresses, then the next 
record in the list will be displayed.

In other display modes the CUT command is available only when an element has been selected . A 
selected element is then cut to the clipboard (ie removed from the display but left on the clipboard). When
any element is selected the element type is shown in the menu bar.

If the selected element is the Index field block then the total content of the currently displayed record is 
cut - this includes the index field and all associated field blocks. If the current database contains further 
addresses, then the next record in the list will be displayed.



Edit Copy Command

If no element is selected then the content of the currently displayed record and all associated field blocks 
is copied. If it is desired to copy only the index field to the clipboard, then the index field block must first 
be selected (by double clicking on it or choosing INDEX from the SELECT menu).

The entire database may be copied to the clipboard using the EXPORT command.

In display modes other than Normal, if an element has been selected, then the element is copied to the 
clipboard (and left in place on screen).



Edit Clear Command

In Normal display mode when EDIT CLEAR is chosen then the entire record (including all associated 
fields) is deleted.

In other display modes a selected element is deleted. It is not copied to the clipboard. 

If the Index field is selected when EDIT CLEAR is chosen then the entire record (including all associated 
fields) is deleted.

In display modes other than Normal the Clear command is available only when an element has been 
selected. 



Edit Paste Block Command

An element from the clipboard is pasted into the form at its default position (the position the element 
occupied when it was copied to the clipboard). 

The paste command is only available when there is an element available on the clipboard (ie. from a 
previous cut or copy command inside dIndex). 

Note that if a field block is pasted from the clipboard an empty field block is created by the paste 
operation. This field block will be filled only if the currently displayed record contains an appropriate field 
with data in it. If it is desired to paste text from the clipboard into a specific field block the PASTE TEXT 
must be used.



Edit Paste record Command

The current contents of the clipboard in text format used to create a new record. If the clipboard data 
contains a single field then the newly created record will show only an index field entry. If the clipboard 
contains multiple fields then the new record's index field block will be filled along with as many Field 
blocks as the clipboard data permits.

A group of records may be imported from the clipboard using the IMPORT command



Edit Paste text only Command

The current contents of the clipboard in text format are used to replace the whole of the currently selected
Text block or field block, so the existing content of the current Text or field block text is lost.

The Paste Text block command is available only when there is text data already available on the clipboard
(ie. from a previous cut or copy command either inside dIndex or in another application).    

Note that the new contents of a Text block will not be visible after this command if either the HIDE TEXT 
BLOCKS or HIDE ALL items of the DISPLAY menu have been checked.

If Paste Text Block is clicked without a text block item having been selected then the command will be 
ignored.



Edit Paste picture Command

The current contents of the clipboard are used to replace the whole of the currently selected Picture, so 
the current Picture is lost. 

The Paste Picture command is available only when there is picture data already available on the 
clipboard (ie. from a previous cut or copy command inside another application, such as Windows 
PaintBrush, Windows Draw, etc.).    

Note that the new Picture will not be visible after this command if the HIDE PICTURES or HIDE ALL item 
of the DISPLAY menu has been checked.



Edit Add Index Command

The dIndex Index editor box appears, displaying an empty editor window. Text may be typed or pasted 
into this box, with any required editing. 

If the OK button is pushed the contents of the editor box are inserted into the current database as the 
index field of the current record. (Any following records are moved forward.) 

The dIndex Index editor box reappears, again displaying an empty editor window and ready for another 
entry. This sequence continues until the CANCEL button is pushed.

If you are using this technique to enter a series of records, do not forget to insert the last record into the 
database by pushing the OK button before pushing the CANCEL button to leave the ADD INDEX mode.

Add Index allows only the index field component of a record to be entered. Any Field blocks on the form 
will be left blank and may be subsequently filled by selecting Fill Field Blocks from the EDIT menu, or by 
entering individual field data in Fill Mode. If it is desired to enter complete record data (ie. an index field 
and associated Field block fillings) then Add Records should be used. 



Edit Add Records Command

The dIndex Index editor box appears, displaying an empty editor window. Text may be typed or pasted 
into this box, with any required editing. 

If the OK button is pushed the contents of the editor box are inserted into the current database as the 
index field the current record. (Any following records are moved forward.) 

The dIndex Field block editor box then appears, ready for the user to enter appropriate text for the first 
field. When text has been entered, or if no entry is required for the specified Field block, the user can 
push the NEXT BLOCK button to display the next Field block. Alternatively if no other fillings are to be 
entered the OK button may be pushed to accept the record as is. 

The Field block editor will close automatically when all the Field blocks defined for the current record have
been filled    - or when the NEXT button has been pushed while the last field block was displayed.

The Field block editor also contains buttons labelled PREVIOUS and CANCEL. If the previous button is 
pushed the editor will display the contents of the preceding field block (if any).    If the cancel button is 
pushed any changes to the field blocks on the current record are abandoned and the field block editor is 
closed.

Once the required fields have been entered and the Field block editor closed, the Index block editor is 
displayed ready for another whole record entry. Once all the required records have been entered the entry
of records may be terminated by pushing the CANCEL button.



Edit Fill field blocks Command

When Fill Field blocks is selected the Field block editor appears for the first field block defined for the 
current record style. [ If the current style contains no Field blocks then the command is ignored.] The 
name of the field block is displayed in the Field block name box at the top of the editor window. If the first 
field block is currently filled the filling text is shown in the field block editor's window and may be edited. 

Once the first field block has been edited the user can proceed to edit the next field block by pushing the 
NEXT button. Again the name of the field block is displayed in the Field block name box at the top of the 
editor window and, if the field block is currently filled, the filling is displayed in the editor and may be 
edited.

This sequence continues until either there are no more field blocks defined in the current style, or the user
presses the OK button. In either case the field block editor box disappears and the current record is 
redrawn using the edited fields.

The Field block editor also contains buttons labelled PREVIOUS and CANCEL. If the previous button is 
pushed the editor will display the content of the preceding field block (if any).    If the cancel button is 
pushed any changes to the field blocks on the current form are abandoned and the field block editor is 
closed.



Edit Index Command

The dIndex Index editor box appears, displaying the index field of the current record. 

The text within the editor box may be edited by inserting new text, cutting text or copying or pasting text 
from the clipboard.

The dIndex Index editor box contain OK and CANCEL buttons. If OK is pressed the current editor display 
is used to replace the index field of the current record in the dIndex Window.

If the CANCEL button is pressed, then any changes made to the current index field are discarded.



Edit Selection Command

Choosing this item while a Text block, Date or Checkbox element is selected will cause the dIndex Text 
block editor to appear. 

The text within the editor box may be edited by inserting new text, cutting text or copying or pasting text 
from the clipboard.

Note that DATE elements are considered as text blocks. In fact they differ from text blocks in that the ^ 
symbol is translated into the current replacement date. The replacement date is supplied whenever the 
record is displayed or printed.

Choosing EDIT SELECTION while a Sequence block is selected causes the Sequence labelling dialog 
box to appear. 

Choosing EDIT SELECTION while a Field block is selected causes the editor dialog box to appear.    
This allows the content of the selected Field to be edited.    Editing may be cancelled by pushing the 
Cancel button.

Choosing EDIT SELECTION while a Barcode block is selected causes the Barcode dialog box to appear. 
This allows the type and content of the barcode to be edited.    Editing may be cancelled by pushing the 
Cancel button.



Format Selection Command

Choosing FORMAT SELECTION while an Index or Field block element is selected will cause the dIndex 
Field block format editor to appear. 

This allows the field contents to be hidden, word-wrapping to be turned on or off, and text to be left or 
right aligned or centred. For Fields blocks it also permits fields to be synthesised from the Index field.

Choosing FORMAT SELECTION while a Checkbox is selected causes the Checkbox format editor dialog 
box. The Checkbox format editor allows the user to define the Text position (left or right of the box), 
vertical alignment (top of text, bottom of text, or middle of text) and the box size (small, medium or large).

Choosing FORMAT SELECTION while a grid is selected causes the Grid editor dialog box to appear. The 
Grid editor dialog box permits the user to define the number of vertical and horizontal grid lines to be 
placed between the boundary box of the grid.



Edit Insert page Command

Insert a new and blank page into the current form after the currently displayed page.



Edit Delete page Command

Delete the currently displayed page and all elements on it. A confirmation is requested before the page is 
deleted.

Note that field blocks may be deleted, but their contents are not effected by deleting the block position 
information. However, after a page containing field blocks is deleted, field blocks on subsequent pages 
may be incorrectly ordered for filling from an existing database.



Options Form sizes Command

The Form size selector dialog box is displayed. This contains a listbox showing the currently available 
form names, and edit boxes which allow the form names and the corresponding length and width 
dimensions and repeat numbers and distances to be changed. 

Clicking on a name in the Forms listbox causes the name to be highlighted and that form to become the 
form for the current style. Double clicking on a form name in the Forms listbox (or clicking on a name 
followed by clicking on the OK button) causes the current form image to be redrawn using the new form 
dimensions.

The Form size selector dialog box also contains OK and CANCEL buttons. When OK is selected any 
changes made within the dialog will be reflected in the form image displayed on the dIndex window. If 
CANCEL is selected any such changes are discarded.



Display Maximise Command

Selecting the Maximise menuitem causes the dIndex window to be redrawn. The current record is 
shown with the current form image format on a scale which is approximately double the actual size; in 
many cases this does not permit the image to be fitted within the current size of the dIndex window.    

All item selection facilities are available in this display mode.



Display Normal/List Command

Selecting the Normal menuitem when dIndex is displaying in Printer View or List mode causes the dIndex
window to be redrawn. The current record is shown using a format in which record fileds are shown 
within boxes, and the field names are shown at the top of each box.

When fields are selected in this display mode, the appropriate field editor is displayed so that the field 
contents may be edited.

Selecting the List menuitem when dIndex is displaying in Normal mode causes the current list of the Index
field of records to be displayed. If dIndex is displaying Marked records (as a result of a Search & Mark 
operation or a Show Marked Only command) the list includes only Marked items; otherwise the list shows 
all items in the current database.

Double clicking on a list entry causes the display to return to Normal mode showing the record which was 
double clicked.



Display Printer view Command

Selecting the Printer view menuitem causes the dIndex window to be redrawn. The current record is 
shown with the current form image format on a scale which approximately the actual size of the printed 
form.

All item selection facilities are available in this display mode.



Display Page view Command

Selecting the Page view menuitem causes the dIndex window to be redrawn. The current record 
appears as the form image at the top left-hand corner of the dIndex window, displayed on a scale which 
will accommodate an image of the printed page of the currently selected printer on the screen.

A fine line outline of the printable area of the printer's output page is displayed to enable the user to check
that the printing will be within these limits.

All item selection facilities are available in this display mode.



Display First page Command

Display the first page of the current form



Display Next page Command

Display the next page of the current form. If the current page is the last page, then the first page of the 
form is displayed.



Display Previous page Command

Display the previous page of the current form. If the current page is the first page, then the display is 
unchanged.



Display Last page Command

Display the last page of the current form



Show Index Command

Selecting SHOW INDEX from the DISPLAY menu invokes the Record Index dialog box. This permits the 
order of records in the database to be changed.



Show Outlines Command

Selecting SHOW OUTLINES from the DISPLAY menu toggles on or off the dotted outlines of the empty or
hidden elements shown on screen. This can be useful for making complex displays less cluttered.



Fit fields Command

Selecting FIT FIELDS from the DISPLAY menu causes dIndex to force field blocks to fit in the space 
allocated for the field. Where field lines are longer than the allowed space, word-wrapping to the next line 
will occur. Text which falls below the limit of the allowed space is clipped (ie. not displayed).



Display Show Marked only Command

Enabling this item causes dIndex to display only those records which have been marked in the current 
database.

When marked records only are being displayed, all record selection facilities (eg. next, previous, first, etc.)
will operate only on marked records. Thus the first form command will display the first marked record.

If no records have been marked on the current database an warning message is displayed.



Display Field block names Command

When selected causes the current form images to be redrawn with the contents of any field blocks being 
replaced by the names assigned to those field blocks when the display is in printer, page or maximized 
mode. The field block names and contents are already shown in normal mode.

[Field blocks do not have to be named, although it is easier to identify and reorder field blocks if they are 
all named.]



Display Show All Command

Selecting this item causes all elements on the form to be made visible when the screen image is drawn in 
printer, page or maximized mode. Any of the HIDE commands which were previously in effect are 
disabled. 

When the SHOW ALL item has been selected a tick mark will appear alongside the menuitem. 



Display Hide All Command

Selecting this item causes all elements apart from the index field block and its associated field blocks on 
the form to be made hidden when the screen image is drawn in printer, page or maximized mode. 

When the HIDE ALL item has been selected a tick mark will appear alongside the menuitem. 



Display Hide Pictures Command

Enabling this item causes all picture elements on the form to be made hidden when the screen image is 
drawn in printer, page or maximized mode. 

When the HIDE PICTURES item has been enabled a tick mark will appear alongside the menuitem. 

Clicking on the menuitem when a tick mark is alongside it causes it to be disabled (ie any pictures are 
made visible).



Display Hide Text blocks Command

Enabling this item causes all text blocks elements (including sequence and date elements) on the form to 
be made hidden when the screen image is drawn in printer, page or maximized mode. 

When the HIDE TEXT BLOCKS item has been enabled a tick mark will appear alongside the menuitem. 

Clicking on the menuitem when a tick mark is alongside it causes it to be disabled (ie any text blocks are 
made visible).



Display Large fonts Command

Selecting Large fonts toggles dIndex's Large fonts function alternately on and off. When the Large fonts 
function is on the Large fonts entry in the Options menu has a tick mark beside it. The default value is on.

When on, the Large fonts function causes dIndex to adjust the size of the displayed fonts so that they are 
readable on screen - even though this may result in a larger display area for the field or Text block 
component than will actually be printed. 

When off, dIndex will attempt to display the fonts on screen at their actual size, even though the text may 
be unreadable or may appear in a distorted style.

Note that the large fonts option is available only when the form image is displayed in printer or maximized 
mode. In Page view all text items are displayed at approximately their actual size in proportion to the form
image size.



Display Set Background command:

Choosing Set Background causes the display of the Background Settings dialog box. This allows the user
to define colours for the window background and the border around the page image. The page itself is 
shown as white.



Display Tile Command

Selection of Tile causes the arrangement of the windows of all currently open Windows applications 
according to the pattern selected from a submenu.

The submenu options are

Rows - windows to be arranged one above the other;
Columns - windows to be arranged one beside the other; and
Overlapped - windows to be overlapped, with dIndex at the front. From this position other 

application Windows may be brought to the front using <Alt><Tab>.



Search menuitem

Selecting SEARCH from the dIndex window menubar invokes the Search & Mark dialog box. This allows 
records to be retrieved from the database by marking the records so that they become visible.



Add Menu options

Choosing ADD ELEMENT causes the display of a submenu containing a list of the available form 
elements:

Field block
Address
Bar
Text block
Picture
Check box
Date
Sequence
Box
Grid
Vertical Line
Horizontal Line
New page

Clicking on New page result in the addition of a new page to the current form, immediately after the 
currently displayed page. The new page is initially blank.

Clicking on any of the other element names causes the cursor to change to a "corner". Dragging the 
cursor over the form image while holding down the left mouse button causes a line (for line elements) or 
rectangle to be drawn on the form image. This line or rectangle represents the initial position of the new 
element. [Textual element will change their size according to the space occupied by the text they contain.]

When the mouse button is released after a text containing element has been added, the appropriate 
editor box will appear so that the textual content may be entered.

When the mouse button is released after a grid element has been added, the grid editor box will appear 
so that the details of the grid may be entered.

When the mouse button is released after a barcode element has been added, the barcode editor box will 
appear so that the details of the barcode type and content may be entered.

Note that empty elements (eg picture blocks which do not contain a picture, or text blocks into which no 
text has been entered) are shown as dotted line rectangles on the screen image. Of course, they do not 
show at all on printed forms.

Once created elements may be moved or, in the case of lines, boxes and pictures, resized, by selecting 
the element and then dragging it to reposition it, or dragging the mouse pointer while holding down the 
shift key to resize the element. 

The cursor keys may also be used    to reposition an element, and the shifted cursor keys to resize an 
element, with the <enter> key being used to complete the operation (or the <escape> key to cancel it).



Options Selection font Command

Choosing Selection font results in the display of the Font selection dialog box for the component currently 
selected (ie. the Address, Text, Date or Sequence block which currently has a dotted box around it). If no 
component is selected the command is ignored.



Options Field font Command

Choosing Field font results in the display of the Font selection dialog box for the Field block components 
of the current form style.

Note that all field block components are rendered in the same font unless a specific field has been 
selected and its font set using the SELECTION FONT item of the OPTIONS menu.



Options Line size Command

Choosing line size when any form element is selected results in the display of the Line size dialog box, 
which provides a list box for the selection of the line thickness used for displaying and printing any lines 
associated with the element. [This will be an underline for text blocks, or the line for vertical or horizontal 
line elements.]

The line thickness may be set to "off" to disable underline printing for text elements by checking the No 
Line check box.



Options Box lines Command

Choosing Box lines when any form element is selected results in the display of the Line size dialog box, 
which provides a list box for the selection of the line thickness used for displaying and printing any box 
lines associated with the element. 

The line thickness may be set to "off" to disable box printing for text elements by checking the No Line 
check box.



Options Field blocks mode Command

Selecting this menuitem toggles dIndex's operating mode between normal and Field blocks mode. When 
Field blocks mode is enabled the menuitem shows a tick mark beside it and FIELD MODE appears in the 
menubar in place of the Record#. [Note that clicking on this position will advance the form displayed to 
the next record of the database even when FIELD MODE is displayed.]

Field blocks mode is provided to allow for rapid editing of field blocks in a sequence of forms when the 
form image is displayed. Double clicking on any field block (which in normally justs selects the block) in 
field blocks mode will immediately bring up the text editor displaying the content of the selected field 
block.

Only the field block contents may be edited in field blocks mode. Most other editing facilities normally 
available from dIndex's main window EDIT menu are disabled in Field blocks mode.

Field blocks mode may be disabled (ie. normal operation restored) by clicking on Field blocks mode while 
it is ticked, or pressing <Ctrl> and <F7> simultaneously.



Options Reorder field blocks Command

Selecting Reorder Field blocks results in the display of the Reorder Field blocks Dialog box.

The order in which field blocks are filled from a record and the order in which they and presented for filling
(using Add Records or Fill Field Blocks) is the order in which the field blocks positions are stored within 
the style sheet. This order may be changed using the Reorder Field blocks Dialog box, and the change 
will be permanent if the style sheet is subsequently saved.



Options Multiple lines Command

The Multiple lines command toggles on and off dIndex's multiple line display for the fields shown in 
Normal display mode. 

When "on", multiple line fields will be displayed on screen as multiple lines, and the menuitem if ticked.

When "off", all multiple line fields are forced to display as single lines, with filled squares representing the 
newline characters.



Options Key strings Command

The Key Strings command invokes the Key strings editor dialog box, which enables key strings to be 
defined or edited.



Snap setting Command

Choosing Snap setting results in the display of the Snap setting dialog box, which allows the snap facility 
to be turned on or off, and allows the snap grid spacing to be defined. 



Options Save defaults Command

Once selected all the form elements' styles currently set will be saved in a style sheet file called 
DEFAULT.DLS. 

When dIndex is started it searches for the file DEFAULT.DLS (using the current path) and, if found, loads 
the style settings previously saved. The original default values may be restored by deleting the file 
DEFAULT.DLS before starting dIndex.



Select Next Command

When Next is selected dIndex will display the form image for next record of the current database. 

If there are no more records in the current database, a message box will appear advising the user of this 
fact.



Select Previous Command

When Previous is selected dIndex will display the form image for the previous record within the current 
database. 

If there are no previous addresses, dIndex will display the first record.



Select First Command

When First is selected dIndex will display the form image of the first record in the current database.



Select Last Command

When Last is selected dIndex will display the form image of the last record in the current database.



Select Search Command

When Search is selected the Search dialog box will appear, prompting the user to enter a search string in 
the Search for box. 

If a string is entered and <enter> is pressed or OK clicked, dIndex will search forward through the current 
list of records starting at the record after the current record, for a record containing the search string. If a 
record containing the search string is found, dIndex will display the image for that record. If no record is 
found which contains the search string, a message box will appear to inform the user of this fact, and 
dIndex will display the image of the last record in the current database.



Select Repeat search Command

When Repeat search is selected the last search string is used for a continuation search, starting with the 
record after the currently displayed record.



Select GoTo Command

When GoTo is selected the Record number dialog box appears, prompting the user to enter the number 
of an record in the current database which it is desired to display on screen. 

If a number is entered and <enter> pressed or the OK button clicked, then the current record display is 
replaced by the display of the image of the record of the number provided. 

If the number provided is greater than the number of the last record in the current database the image of 
the last record in the list is displayed.



Select Mark Records Command

When Mark is selected the Mark Records dialog box appears. This enables the user to view the current 
database in a scrollable list box. 

An Item within the list box may be marked by clicking on the item with the left mouse button, or by moving
the focus to the required item with the cursor keys and the pressing the space key.

Pressing enter or pushing the OK button closes the Mark dialog box and ensures that all highlighted items
within the listbox are marked for dIndex's use. Pushing the Cancel button closes the dialog box without 
incorporating the highlighted items into the current marked list.



Record number

This item in the menu bar displays the number of the currently displayed record within the current 
database file.

Marked records show a « symbol alongside the number.

Clicking on the item causes the image of the next record to be displayed (if it exists).

Clicking on the item while holding down the shift key causes the previous record to be displayed.

Clicking on the item while holding down the <Ctrl> key cause the current record to be marked if it was 
previously unmarked, or unmarked if it was previously marked, and does not advance the display to the 
next record. 



Page number

This item in the menu bar displays the number of the currently displayed page of the form.

Clicking on the item causes the image of the next page to be displayed (if it exists). If the current page is 
the last page of the form, then clicking on the item causes the display of the first page of the same form.



Batch Editor dialog

(Professional Plus version only)

The Batch Editor dialog box shows a list of the current database records (Index fields) and a list the 
current batch commands in the form:

number of copies <space> identifying string

The number of copies is a numerical value (between 1 and 16,000) which determines the number of 
copies of the specified record to be printed.

The identifying string is a string which is searched for when dIndex attempts to locate the record required 
for printing. It must be unique within the database, and was originally intended to be formed from a code.

Batch commands may be added by entering appropriate values into the number and string edit boxes and
then pushing the ADD button. Alternatively double clicking on a record in the current records listbox 
transfer the first word of the chosen field to be copied into the string edit box. The field copied into the 
string edit box may be selected from the Fields combo box.

Double clicking on a batch command also causes the number and string edit boxes to be filled with data 
from the selected command. When a command is highlighted it may be deleted (by pushing the DELETE 
button) or replaced by the current contents of the number and string edit boxes (by pushing the 
REPLACE button).

A list of batch commands may be saved in a Batch file (extension .DLB) by pushing the SAVE button, and
a previously saved batch file may be opened by pushing the OPEN button.

The Batch Editor dialog also contains OK and Cancel buttons, both of which close the dialog. If the OK 
button is pushed and a batch file has not been saved after editing, the user will be prompted to save the 
file.



Batch Print dialog

(Professional Plus version only)

The Batch Print dialog box shows the current batch printing options:

The current printer
The current Replacement date
The current Batch file

In each case a push button permits the current value/options associated with the item to be changed prior
to printing.

The dialog contains a check box which, if checked, causes the identifying strings in the batch commands 
to be searched for only in the Index field of the database records. This can be useful if the identifying 
string may occur in the other fields of more than one record. When the check box is not checked all fields 
of each record are search in an attempt to match the identifying string.

The dialog also contains PRINT and Cancel buttons.

If the PRINT button is pushed the specified batch file will be opened and the batch commands within the 
file obeyed. These permit a specified number of copies of specified record to be printed.

If the Cancel button is pushed the dialog is closed. Note that if options/values of any parameter has been 
changed while the dialog was open, such changes are NOT undone when the dialog is cancelled.



Form size dialog

The Form size selector dialog box is displayed. This contains a listbox showing the currently available 
form names, and edit boxes which allow the form names and the corresponding length and width 
dimensions and repeat numbers and distances to be changed. The list of available form names and sizes 
is stored in a disk file called DINDEX.INI and is read in when dIndex is started.

Note: DINDEX.INI does not appear on the distribution disk. It is created when Save on OK is selected 
from within the Form size dialog box before the dialog is closed by pushing the OK button.

Forms listbox Clicking on a name in the Forms listbox causes the name to be highlighted and that 
form to become the form for the current style. It also results in the dimensions of that 
form being displayed in the Length & Width edit boxes (see below).    Double clicking 
on a form name in the Forms listbox (or clicking on a name followed by clicking on the 
OK button) causes the current form image to be redrawn using the new form 
dimensions.

Name editor box Selecting a name in the listbox (by clicking on it once) results in the name being 
copied to the name editor box (below the listbox). Clicking on the name editor box 
causes a caret (editing cursor) to appear in the box. The name may now be edited - by
deleting existing characters using the delete and backspace keys, and typing in new 
characters.    Note that this change will be reflected in the Forms listbox only if the 
Accept Changes button is pressed after the new name has been created. 
Furthermore, such changes only affect the current dIndex session, unless the change 
is saved (in DINDEX.INI) by clicking on the Save on OK box (see below).

Length & width The height and width edit boxes contain the height and width (in millimetres) of the 
currently selected form, and these values may be edited by clicking on the edit box 
and deleting/inserting values. Such changes only affect the current dIndex session, 
unless the change is saved by clicking on the Save on OK box (see below).

Repeat distances and numbers:    The height and width repeat distance and number edit boxes contain 
the repeating distances (in millimetres) and repeating numbers of the currently 
selected forms, and these values may be edited by clicking on the edit box and 
deleting/inserting values. Such changes only affect the current dIndex session, unless 
the change is saved by clicking on the Save on OK box. Repeat distance values are 
only relevant where each printer page contains more than one form, for example for 
sheets of labels.

Accept Changes Clicking on the Accept Changes box causes the current contents of the name, height 
and width edit boxes to replace the properties of the currently selected form. These 
changes will remain in effect until dIndex is terminated. If the changes are saved, by 
clicking on the Save on OK box before closing the dialog by pushing the OK button 
(see below), then the change becomes permanent. Restarting dIndex will cause the 
list of available form names and sizes to be read in from the disk file DINDEX.INI.

Save on OK Clicking on the Save on OK box prior to closing the dialog by pushing the OK button 
causes the current list of form names (and sizes) to be saved in a disk file called 
DINDEX.INI which is read in when dIndex is started. This allows changes in the 
specifications of available forms to be saved for future use. Confirmation is requested 
before the changes are actually saved on disk.

Note that the factory default values for the Form size names and dimensions may be restored by deleting 
the DINDEX.INI file before starting dIndex.



The Form size selector dialog box also contains OK and CANCEL buttons. When OK is selected any 
changes made within the dialog will be reflected in the form image displayed on the dIndex window. If 
CANCEL is selected any such changes are discarded.



Font selection dialog

The Font selection dialog box allows the user to select the fontname, style (ie. regular, bold or italic) and 
size of the font which will be used to render the component (ie the Index field, Text block, Sequence label,
etc.).    This selection is dependent on the currently selected printer and, in some case, on the orientation 
of the page for that printer. 

The Font selection dialog box contains the following items:

Font listbox Clicking on a fontname in the Font listbox selects the font for use in rendering the 
current component; this fontname is copied to the edit box above the list . It also 
causes the list of available font sizes in the size listbox to be updated. Note that only 
fonts available for the currently selected printer are included in the Font listbox.

Size listbox Clicking on a font size in the Size listbox selects the size for use in rendering the 
current component; this size is copied to the edit box above the list. If no size appears 
in the listbox it will be because the user has no choice over the size - ie. the printer is 
only capable of printing the specified font in a fixed size. For TrueType, PostScript and 
other continuously scaleable fontsize printers a fixed number of options appear in the 
size listbox, although any integer point size in the range 4 - 144 points may be entered
in the edit box and will be used for printing if the requested value is within the printer's 
capability.

Style listbox The font style box shows the font styles available for the currently selected font 
(including regular, italic, bold, and bold and italic). Clicking on one of these entries will 
select the style with which the font will be rendered on the screen image and printed 
output. 

Leading The value in the Leading edit box shows the line spacing for a multi-line text block, 
and may be changed by the clicking the mouse button within the edit box and editing 
the number shown. Note that if the line spacing is set too small then the lines will 
overlap one another.

Auto Leading If the Auto Leading checkbox is checked then a default line spacing (110% of the font 
point size) is used. If the Auto Leading checkbox is unchecked then the line spacing is 
set to the value displayed in the edit box. 

Sample The sample box shows a sample of the currently selected font and style. 

Colour properties of the current element are shown in the Colour combobox, from which alternative 
colours may be selected (Professional version only). 

The Use as defaults check box causes the current settings to be saved and used to initialise any textual 
elements created after the dialog is closed by pushing the OK button.

The Font selection dialog box also contains OK and CANCEL buttons. When OK is selected any changes
made within the dialog will be reflected in the Form image. If CANCEL is selected any such changes are 
discarded.



Record Index dialog

The Record Index dialog contains a list box in which the index fields of records are displayed. The order 
of the items in the listbox, and the order in which the records are displayed in the dIndex window, may be 
changed by pushing one of the Sort On radiobuttons. 

The records may be arranged in the order in which they appear in the record file, or in alphabetical 
ascending or descending order based on the index field or any other field specified by highlighting the 
field name in the small listbox below the Sort On box.

The dialog contains a checkbox marked Descending. If this box is checked then the records are arranged 
in reverse alphabetical order or, in the case of File Order sorts, in the reverse order in which they appear 
in the record file.    If the checkbox is not checked then the records are arranged in alphabetical order or, 
in the case of File Order sorts, in the file order.

The dialog contains a checkbox marked Last word. If this box is checked then the records are arranged in
alphabetical order based on the last word of the first line of the selected indexing field. This is particularly 
useful for indexing on last names. If the check box is not checked, then indexing is based on the first 
words within the selected field.

The editor dialog box contains OK and CANCEL buttons. If OK is pressed the highlighted record in the 
Entry listbox is made the current record as the dialog closes and the dIndex window display is redrawn.    

If the Cancel button is pressed then the display reverts to the record sequence at the point which was 
displayed before the dialog box was invoked. Note that if a sort has been carried out within the dialog, 
then pushing the Cancel button does not undo the sort.



Search & Mark dialog

The Search & Mark dialog contains an edit window for entering a search text which may be used to mark 
or unmark records which contain the search text within specified fields. 

A search over all records within the current database is initiated by pushing either the New button, in 
which case any previously marked or found items are unmarked before the search begins, or Widen, in 
which case the search covers all records irrespective of whether they are already marked or found.

A search may be confined to records which have already been marked or found by pushing either the 
Narrow button, in which case marked records which do not contain the search string are unmarked, or the
Exclude button, in which case records which do contain the search string are unmarked.

The fields searched within records may be specified by pressing the required Search radiobutton. The 
search may be confined to the Index field, or extended over All fields, or Selected fields may be search by
selecting named fields within the Fields listbox

When a search has been carried out the total number of records found so far is displayed in the Found 
records box at the bottom of the dialog.

The Search and Mark dialog box contains OK and CANCEL buttons. If OK is pressed the    dialog is 
closed and the dIndex window is shows only marked records in the current database. 

If the CANCEL button is pressed, then the dIndex window display is restored displaying the record 
displayed before the dialog was invoked.



Editor dialog

The editor dialog contains an edit window for entering or editing text and a number of buttons for initiating 
editing commands.

The text within the editor box may be edited by inserting new text (at the position of the cursor), cutting or 
copying text (either by highlighting with the cursor using the mouse or shifted cursor keys, and then either 
clicking on the CUT or COPY buttons, or using the standard accelerator keys - Ctrl+Ins for COPY, 
Shift+Del for CUT, and Del for Clear), or pasting text from the clipboard to the current cursor position by 
selecting the PASTE button or pressing Shift+Ins. 

Any editing operation may be undone by pressing the UNDO button.

The editor box contains a KEY button, which, when pushed, causes the display of a list box showing the 
available key strings. Selecting a key string from the listbox and clicking on the listbox's SELECT 
menuitem, or double clicking on a key string, causes the listbox to be closed and the selected string to be 
copied into the editor at the position of the caret.

When editing a field block, the editor also contains a button marked IMAGE. Pushing this button allows an
image file to be selected for filling the current field.

The editor dialog box contains OK and CANCEL buttons. If OK is pressed the current editor display is 
used to replace the corresponding element in the dIndex Window.

If the CANCEL button is pressed, then any changes made to the current text are discarded.

Note that the <enter> key provides a newline when the cursor is within the editor box. To access the OK 
button without a mouse the user should press the <tab> key until the highlight moves to the OK button. 
The button may then be pushed by pressing either the <space> or <enter> keys. The <escape> key may 
always be used to push the CANCEL button.



Field block format editor dialog

The Field block format editor dialog contains a combo box for entering, editing or selecting the name of a 
field block, and a number of buttons for selecting how the field should be filled. It also contains checkbox 
which permit wordwrapping to be turned on or off, or the contents of the field to be hidden from view on 
the screen (and omitted from printing).

When the editor is invoked during the creation of a field block the combo edit box is initially empty, 
permitting the user to enter a suitable name for the field being created.

It is sometimes useful to create a field which is the duplicate of an existing field. This can be 
accomplished by clicking on a field name in the combo's list box - which shows the names of existing 
fields. Note that a when duplicate field is created in this manner the field's name becomes preceded by an
= symbol, and the field contents cannot be edited (except by editing the original field of the same name).

The contents of a field block may be derived from field data of the current record of the current database, 
or from the first (index) field of the current record. When the latter is required the user may choose to 
extract the first word, the last word, the first and last words, the first line, or the last but one line of the 
index field. These combinations allow a variety of useful elements to be extracted from, for example, a 
name and address entry. Fields which are filled from the Index field cannot be edited directly.

The editor also contains a group of radiobuttons for setting the justification of text which will appear in the 
field. This may be set to Left justify, Center or Right justify. 

A checkbox marked Wordwrap, when checked, causes the block's text to be forced into the area defined 
for the block on the form image, by wrapping word around to the next line if necessary. Note that text 
which would fall outside the allowed block area is clipped and will not be visible when Wordwrap is 
checked.

The dialog box contains OK and CANCEL buttons. If OK is pressed the dialog is closed and the current 
form redrawn using updated field block details.    If the CANCEL button is pressed the editor is closed and 
any changes made to the field block details are discarded.



Field block editor dialog

The Field block editor dialog contains an edit window for entering or editing field block text and a number 
of buttons for initiating editing commands. It also displays the name of the field block and the page 
number of the page holding the field block.

The text within the editor box may be edited by inserting new text (at the position of the cursor), cutting or 
copying text (either by highlighting with the cursor using the mouse or shifted cursor keys, and then either 
clicking on the CUT or COPY buttons, or using the standard accelerator keys - Ctrl+Ins for COPY, 
Shift+Del for CUT, and Del for Clear), or pasting text from the clipboard to the current cursor position by 
selecting the PASTE button or pressing Shift+Ins. 

Any editing operation may be undone by pressing the UNDO button.

The editor box contains a KEY button, which, when pushed, causes the display of a list box showing the 
available key strings. Selecting a key string from the listbox and clicking on the listbox's SELECT 
menuitem, or double clicking on a key string, causes the listbox to be closed and the selected string to be 
copied into the editor at the position of the caret.

Pressing the <F2> key will cause the current replacement date to be inserted into the text at the 
position of the caret.

The editor contains buttons marked NEXT FIELD and PREVIOUS FIELD. Pushing these buttons will 
cause the editor to display the text content of the next or previous field block. The sequence of the field 
blocks may be defined using REORDER FIELD BLOCKS on the OPTIONS menu.

The editor also contains a button marked IMAGE. Pushing this button allows an image file to be selected
for filling the current field.

The editor dialog box contains OK and CANCEL buttons. If OK is pressed the editor dialog is closed and 
the current form redrawn using updated field block contents. Note that if the editor was invoked using 
ADD RECORDS, then pushing the OK button will cause the Index editor dialog box to be displayed.

If the CANCEL button is pressed the editor is closed and any changes made to the field blocks of the 
current record are discarded. Note that if the editor was invoked using ADD RECORDS, then the field 
blocks of previous records are not deleted when Cancel is pushed, but the entry of whole records is 
terminated.

Note that the <enter> key provides a newline when the cursor is within the editor box. To access the 
NEXT FIELD, PREVIOUS FILED, OK or CANCEL buttons without a mouse the user should press the 
<Tab> key until the highlight moves to the required button. The button may then be pushed by pressing 
either the <space> or <enter> keys. The <escape> key may always be used to push the CANCEL button.

Pressing the <Tab> key once within the editor box will move the focus to the NEXT FIELD button, so the 
sequence <Tab> then <Enter> will cause the next field block to be loaded into the editor.



Barcode editor dialog

The Barcode editor allows the user to define the type and content of a barcode.

The dialog contains a Coding scheme combo box, which displays the name of the currently selected 
coding scheme. Clicking on the selector arrow causes a list of the availbale coding schemes to be 
displayed. [See the printed documentation for details of the coding schemes available.]

Below the coding scheme box is a box which displays the number of characters which must be provided 
for encoding to form the barcode, and a number of check boxes which may be used to specify options.

The Include text checkbox, when checked, causes the encoded digits to be printed below the barcode. In 
common with normal practice, encoded check digits are not printed.

The Auto check digit checkbox, when checked, causes the automatic calculation of check digits for those 
encoding schemes which require check digits. Note that checking or unchecking this box may change the 
number of digits which the user must supply for encoding. If this box is not checked then the user is 
responsible for inclusion the check digit(s) in the text provided for encoding - and for ensuring that the 
digit is valid.

The Nominal size image checkbox, when checked, will cause the size of the barcode to be modified so 
that it is printed at the nominal size recommended for the barcode standard. If the box is unchecked, then 
the user is responsible for ensuring that the barcode is of a suitable size for reading. Note that some 
barcodes do not have a nominal size.

On the lefthand side of the dialog box a series of radiobuttons allows the user to select the source of the 
text for encoding. This may be a fixed string, an automatically incremented sequence (with a fixed prefix 
and a fixed length but incrementing suffix), or the content of the Index field (the First field) or a named 
field within the database file. The latter permits specific codes to be associated with each record of the the
current database - but the user is responsible for ensuring that the corresponding field contains an entry 
of the correct length.

When a named field is selected, the name of the current field is shown in the combobox. Clicking on the 
selection arrow causes a drop-down list of the available fields to be displayed. Double clicking on a field 
name causes this to become the current source for the barcode data.

The editor also contains OK and Cancel buttons. If the OK button is pushed the dialog is closed and the 
target barcode redrawn as specified within the dialog. If the Cancel button is pushed then the dialog box 
closes and any changes made within the dialog are ignored.



Key strings editor dialog

The key strings editor dialog box provides facilities for entering and editing key strings.

The dialog contains a listbox which shows the initial characters of the key strings, each string being 
constrained to one line of the listbox, and a multiline edit box which may contain a single key string at any 
one time.

Entering a string into the edit box and the pushing the ADD STRING button causes the content of the edit 
box to be added to the list box as a key string.

Any string in the list box may be selected (by clicking on it with the mouse pointer).

A selected sting may be deleted by pushing the DEL STRING button, or copied to the edit box by pushing
the EDIT STRING button (or by double clicking on the selected string).

If a string in the listbox is selected and the REPLACE STRING button is pressed, then the current content
of the edit box replaces the whole of the selected string in the list box.

The key strings editor dialog box also contains OK and Cancel buttons.    Pushing the cancel button 
closes the dialog without effect any changes in the defined key strings.

Pushing the OK box causes the existing key strings to be replaced by those in the listbox before the 
dialog closes.



Grid editor dialog

The grid editor dialog permits the user to define or edit the layout of a grid element.

The Grid editor dialog box    permits the user to define the number of vertical and horizontal grid lines to 
be placed between the boundary box of the grid. [Note that the boundary box itself may be omitted, or 
drawn with a selected line thickness by choosing BOX LINES from the options menu]. 

The user may also elect to retain the existing line spacing (if one has been defined) or to equalise the line 
spacing, by pressing the appropriate radiobutton before exiting the dialog.

In addition to the OK and CANCEL boxes, which result in the grid being recreated (the OK button) or left 
as is (the cancel button), the dialog box also contains a MOVE LINES button. 

If the MOVE LINES button is pushed the dialog box disappears but the grid remains selected and the 
word GRID EDITING appear in the menu bar. In this mode, double clicking on a specific grid line will 
select the line (the selected line will be shown as a broken line) and once selected a line may be 
repositioned by dragging (with the left mouse button held down).

The grid lines may be adjusted in this way until either the right mouse button is clicked or the <esc> key is
pressed. In either case Grid editing mode is closed and the grid is redrawn using the newly defined line 
positions.



Checkbox editor dialog

The Checkbox format editor allows the user to define the style of the checkbox by checking boxes within 
the dialog.

The Text position (left or right of the box), vertical alignment (top of text, bottom of text, or middle of text) 
and the box size (small, medium or large) may be specified.

The editor also contains OK and Cancel buttons. If the OK button is pushed the dialog is closed and the 
target checkbox redrawn as specified within the dialog. If the Cancel button is pushed then the dialog box 
closes and any changes made within the dialog are ignored.

Note that Check boxes are intended for manual checking on printed forms. dIndex does not check 
checkboxes.



Snap setting dialog

The Snap setting dialog permits the user to define the spacing of an invisible grid on the screen, so that, 
when Snap is on, any elements which are created or selected, moved or resized, will have their corners 
moved to the nearest point on the grid where vertical and horizontal lines intersect.

The dialog contains a checkbox labelled Snap to grid which, when checked causes the snap feature to be
on.

The dialog also contains an edit box    labelled Grid size in mm. A value in the range 1 - 10 may be 
entered into this box.

If the OK button is pushed the dialog is closed and the value displayed in the edit box becomes the 
effective grid size for both vertical and horizontal lines. However, the snap facility is only operative if the 
Snap to grid checkbox is checked.

If the Cancel button is pushed then the dialog box closes and any changes made within the dialog are 
ignored.

Note that the snap facility effects only elements which are created, selected, moved or resized while the 
facility is on. Elements already on the image which are not selected while snap is on will not change their 
positions or sizes.



Lines dialog

The Line size dialog box provides a list box for the selection of the line thickness used for 
displaying and printing any lines associated with the element. [This will be an underline for text 
blocks, or the line for vertical or horizontal line elements.]    

Line thicknesses of thin (one pixel on the display screen and the default thickness on printers), 0.5, - 10
mm are provided, although some of these cannot be shown in the correct size on all screens. Note that 
some printers (such as dot matrix printers) are not able to reproduce lines with thicknesses other than an 
integral number of pin diameters. The line thickness may also be set to "off" to disable underline printing 
for text elements by checking the No Line check box.

The colour of the current line is shown in the sample line printed alongside the size combo box, and may 
be changed by pushing the Colour button and selecting a suitable colour from the Colour dialog. 

Note that colours are selected from those available for the display screen, and in the case of 
monochrome displays the "colours" will be shades of grey.    When coloured elements are printed they are
rendered in the nearest colour or grey available on the printer.

The Line size dialog box also contains OK and CANCEL buttons. When OK is selected any changes 
made within the dialog will be reflected in the image displayed on the dIndex window. If CANCEL is 
selected any such changes are discarded.



Print dialog

The Print dialog box requests confirmation that the user wishes to print, and allows the user to change the
number of copies of each form printed, and the range of Records printed (current, range, marked or all), 
or to check or change the current printer setup.    

The current printer is identified in the current printer box. Options for printing may be further specified by 
opening the Print Options dialog by pushing the OPTIONS button. Options include the setting of the left 
and top printer margins, and centred or right feeding of the forms into the printer

If OK is selected then the form image is printed for the currently selected range of records on the currently
selected printer using the current printer parameters (eg the port, quality and orientation). During printing 
a message box is visible on screen, allowing the user to cancel printing if required. 

The Print dialog box contains a Printer Setup button which causes the currently selected printer setup 
dialog box to appear on the screen, and allows the user to change the parameters for printing.

The Print dialog box also contains a CANCEL button, which returns the user to the dIndex Window 
without initiating printing. Note that if Printer Setup has been called during the Print dialog, any changes in
the setup for the specified printer are carried out when the Setup dialog is executed and cannot be 
cancelled by selecting cancel in the Print dialog.



Select printer dialog

The Select Printer dialog box shows a list of the printers available in the user's Windows environment.    
The selection is made by moving the highlighted entry to the desired printer name, either by clicking on 
the name with the mouse pointer or by using the cursor keys to scroll the highlight. The highlighted printer
name may then be selected as the current printer by either double clicking on the name, clicking on OK, 
or pressing the enter key. 

The dialog also contains a SETUP button which may be used for summoning the    Setup dialog box for 
the currently selected printer.

Note that changes to printer ports, connections and network printers must be carried out via the Windows 
Control Panel.



Printer setup dialog

The current printer device driver options dialog box permits the user to change the setup of the current 
printer.

The options available depend on the nature of the printer, but many will allow the selection of the paper 
size and orientation (landscape or portrait), the paper feed (manual or feeder), and the graphic image 
resolution. 

After the desired options have be chosen, they may be set as the current options by clicking on OK or 
pressing the enter key. Alternatively the dialog may be cancelled by pressing the <esc> key or clicking on 
Cancel with the mouse pointer. 

Note that changing the printer setup and clicking on OK causes the changed setup to be used within 
dIndex but does not effect the default setup for that printer for other Windows applications.    
Consequently other Windows applications which subsequently access that printer will use continue to use
the default printer setup.    

dIndex will save the modified printer setup within the style sheet for the current form if this style sheet is 
saved after the printer device driver dialog box has been displayed. 



Reorder field blocks dialog

The Reorder Field blocks Dialog box contains a listbox showing the names of the currently defined field 
blocks. Any individual field block name may be selected (by double clicking on it). When selected, the 
name is shown in normal type (not reversed) with a box around it. Holding the left mouse button down the
selected item may be dragged (the reversed text bar shows the current position of the drag) to a new 
location within the list. When the mouse button is release the selected item is moved in the list to a 
position before the currently highlighted item.

A selection may be cleared by pushing the Clear button.

The Reorder Field blocks dialog box also contains OK and CANCEL buttons. When OK is selected any 
changes made within the dialog will be reflected in the form image displayed on the dIndex window and in
the order in which field blocks are presented for filling. If CANCEL is selected any such changes are 
discarded.

Field blocks named with an = as the first character are filled by copying the contents of another Field 
block (see section 3.13). Consequently duplicate field blocks are not filled by the user and the order in 
which their names appear is of no significance. Duplicate field blocks do not appear in the listbox of the 
Reorder Field blocks Dialog box.

Note that the order of fields stored within records in a database file cannot be reordered. Consequently, 
once you have designed a database and built up a number of records and fillings on file you cannot 
reorder the Field blocks of the form's style without disorganising the display of previously filed data.



Sequence labelling dialog

The Sequence labelling dialog box contains an edit box for a Sequence Prefix. Clicking on the edit box 
with the mouse pointer, or using the Tab key until a caret (editing cursor) appears within the edit box, 
allows the user to type in a Prefix or edit an existing Prefix.

The Sequence labelling dialog box contains an edit box for the Start number - ie. the Sequence number 
which will be used for the first record in the current database. The Sequence numbers for subsequent 
addresses are calculated by incrementing the sequence number for each record after the first.

The Sequence labelling dialog box contains a Sequence duplicates checkbox for enabling sequences 
numbers to be incremented when multiple copies of an form are printed. If the Sequence duplicates 
checkbox is checked then the sequence number is incremented between copies of the form being printed.
Thus several copies of a single record form can be printed differing only in the value of the sequence 
number.

The Sequence prefix may be any textual characters (up to 15 characters), while the sequence number 
may contain a maximum of 7 digits. [If a space is required between Prefix and Sequence number the 
Prefix must end with a space character.]

The Sequence labelling dialog box also contains OK and CANCEL buttons. When OK is selected any 
changes made within the dialog will be reflected in Sequence labelling used for the form image displayed 
on the dIndex window. If CANCEL is selected any such changes are discarded.



Save dialog

The Save file dialog box, which allows the user to name a file for saving the current Database or Style. 

The dialog box shows the current directory, which may be changed using \ etc. 

Files are automatically saved with a default extension unless an alternative extension is explicitly included
in the filename.

The default extensions are:

.DLX    for database files

.DLS    for style files.



Export dialog

The Export Database dialog box permits the user to select the line, field and record separators which 
should be employed when exporting a database. Several default combinations are provided and are 
described under the Import dialog.    If any of the standard options is selected, by clicking on the relevant 
radio button, the separators are shown in the separator string edit boxes at the top right of the dialog box. 

Note that the field separators are used to separate field block contents from each other and from the 
index field.

The user may define any required line, field and record separator strings by entering any combinations of 
printable characters or the symbols specified in the table above to represent the non-printable characters,
up to a maximum of 12 keypresses, into the relevant edit box.

If the user-defined format is selected, then any separators entered into the edit boxes will be stored in the 
style sheet for the current form.

The Export Database dialog box permits the user to specify that only marked records should be exported 
(by checking the Export marked records only checkbox). 

The Export Database dialog box also permits the user to select the destination of the export, which may 
be a disk file or the Windows clipboard, by clicking on the relevant radio button. 

If export is to the clipboard, then clicking on OK will initiate the export. If export is to a disk file, then 
clicking on OK causes the Save Address file dialog box to be displayed.



Import dialog

The Import Database dialog box permits the user to select the line, field and record separators which 
should be employed when importing a database. Several default combinations are provided including the 
standard dIndex separators, the <tab> and <enter> (ie. new paragraph) separators employed in most 
spreadsheets (such as Excel), and a "blank line" record separator frequently employed in databases 
maintained by word-processors. If any of the standard options is selected, by clicking on the relevant 
radio button, the relevant separators are shown in the separator string edit boxes at the top right of the 
dialog box. The strings are shown using the following conventions for non-printing characters:

character ASCII code symbol

backspace 08 \b
tab 09 \t
new paragraph 13    10 \p
newline 10 \n
return 13 \r
vertical tab 11 \v
formfeed 12 \f

Printable characters are displayed in the normal manner.

Note that the field separators are used to separate field block contents from each other and from the 
index field.

When importing a single field database the field separator should be blank.

The user may define any required line, field and record separator strings by entering any combinations of 
printable characters or the symbols specified above to represent the non-printable characters, up to a 
maximum of 12 keypresses, into the relevant edit box.

If the user-defined format is selected, then any separators entered into the edit boxes will be stored in the 
style sheet for the current form.

The dialog also contains a Check box labelled Remove ". When this box is checked any quotation marks 
within imported fields are removed. This facility is intended to allow the importation of comma delimited 
data which contains quotation marks around text fields.

The Import Database dialog box also permits the user to select the source of the import, which may be a 
disk file or the Windows clipboard, by clicking on the relevant radio button. The clipboard may be selected
as the source of import only when the clipboard contains text-format data.

If importation is to be from the clipboard, then clicking on OK will initiate the import. If importation is to be 
from a disk file, then clicking on OK causes the Open file dialog box to be displayed (see OPEN).



File Load dialog

The Load/Open file dialog box allows the user to select an file for loading or opening. 

The dialog box shows the list of file names available in the current directory, using the default extension 
for the relevant file type. An alternative selection or an alternative drive and/or path may be entered into 
the rectangle headed Open File Name.

Pushing the OK button causes the file to be loaded.

The default extensions are:

.DLX    for database files

.DLS    for style files.



GoTo dialog

When GoTo is selected the Record number dialog box appears, prompting the user to enter the number 
of an record in the current database which it is desired to display on screen. If a number is entered and 
<enter> pressed or the OK button clicked, then the current record display is replaced by the display of the
form image of the record of the number provided. If the number provided is greater than the number of the
last record in the current database the form image of the last record in the list is displayed.

The Record number dialog box contains a checkbox marked End. If checked this causes the dIndex to 
display the last record in the current database - any number in the Record number box is ignored.

The Record number dialog box also contains a CANCEL button which, when selected, closes the Record 
number dialog box without changing the currently displayed record.



Search dialog

The Search dialog box prompts the user to enter a search string in the Search for box. If a string is 
entered and <enter> is pressed or OK clicked, dIndex will search forward through the current list of 
records starting at the record after the current record, for a record containing the search string. If a record
containing the search string is found, dIndex will display the content of that record. If no record is found 
which contains the search string, a message box will appear to inform the user of this fact, and dIndex will
display the content of the last record in the current database.

If the search is required to search the entire database the user should display the first record of the list 
(see First, above) before selecting Search.

The Search dialog box contains a checkbox marked Match case. If checked this causes the search to be 
carried out in a case sensitive mode. If the box is unchecked the search is carried out without regard to 
case.

The Search dialog box also contains a CANCEL button which, when selected, closes the Search dialog 
box without any search taking place.



Mark dialog

The Mark dialog box contains a fully scrollable list box which will display each index field of a database on
a single line. The vertical scroll bar or the cursor keys may be used for scrolling any specific record into 
view.

Marked records are shown in the listbox as highlighted or reversed.

Any record may be marked by clicking on it once with the left mouse button, or by moving the focus bar 
(indicated as a dotted rectangle) onto the required record with the cursor keys and then pressing the 
space bar.

A record which is already marked may be unmarked by clicking on it a second time (or by using the key 
operation described for marking).

All marked items may be unmarked by pushing the Clear All button.

A range of records may be marked by using the up and down cursor keys while the <shift> key is held 
down.

Records containing a specified string of characters (eg. LONDON) may be marked by entering the 
required string into the mark on edit box and then pushing the mark button. Marking is applied to all 
addresses which contain the specified string. The operation may be made case-sensitive by checking the 
case sensitive check box. By default the operation is not case sensitive.

The total number of marked strings is shown above the listbox.

Pushing the OK button closes the box.

Pushing the Cancel button closes the dialog, but any marking or unmarking which had been carried out 
while the list box was displayed is discarded.

Double clicking on any address in the list box (marked or unmarked) cause the dialog box to close and 
the image of the double-clicked record to be displayed.



Dates

The ^ symbol in text blocks is translated into the current replacement date before displaying or printing. 
The current replacement date defaults to the current date, but may be changed within the Replacement 
date dialog, invoked by selecting Set ^ to date from the OPTIONS menu.

Fields may also contain the Replacement date symbol but THIS MUST BE THE FIRST CHARACTER OF
THE FIELD.

Advanced dates (ie. dates a set number of days in advance of the replacement date) may also be 
specified by following the ^ symbol immediately by a plus sign and a numerical value in the range 0 - 
1024. eg. ^+7

Advance dates are particularly useful for creating "sell by" and "best before" labels, or for printing expiry 
dates on database printouts.

The Replacement date dialog box may be summoned by choosing Set ^ to Date on the OPTIONS menu.

The Replacement date dialog contains edit boxes which allow the day, month and year numbers to be 
edited - either by typing in a direct replacement, or by using the adjacent scroll bars to adjust the value 
displayed.

The dialog also contains two radio buttons, which allow either the long or short date styles to be used 
when the replacement date is evaluated.

Note that the format of both the long and the short date styles may be chosen from the Window Control 
Panel (International section).

The dialog also contains OK and Cancel buttons. If OK is pushed then the dialog is closed and any 
replacement dates in the current image are displayed using the data set in the dialog.

If Cancel is selected the dialog is closed and any changes are discarded.



The Background Settings dialog

This allows the user to define a colour for the printer view window background and the border around the 
page image. The page itself is shown as white.

The dialog contains a box drawn in the current background colour, which itself contains a white rectangle 
with a border in the current page border colour. The dialog contains pushbuttons labelled BACKGROUND
and BORDER. Pushing either of these results in the display of the Colours dialog box which may be used 
for colour selection.

The Background Settings dialog also contains OK and Cancel buttons. If the OK button is pushed the 
dialog is closed and the current image redrawn. The redrawn display will be shown using the selected 
colours for background and page border if the image is currently in Printer view or Page view mode.

If Cancel is selected the dialog is closed and any changes are discarded.



The Colours dialog

The Colours dialog displays samples of the colours available within Windows. Double clicking on one of 
these colours (or single clicking on a colour followed by pushing the OK button) causes the Colours dialog
to close, and the current element to be redrawn using the new colour.

The dialog may be cancelled by pushing the Cancel button.



Adding a barcode

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select BARCODE 
from this menu by clicking on it.

The menu disappears and the mouse cursor changes to a top left-hand corner. Now move the mouse 
cursor to the point on the form at which you wish the top left hand corner of the barcode to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right. A box is drawn on the form, representing the region which will hold the barcode.

Release the left mouse button.

The barcode editor dialog box appears, showing the options available for the encoding scheme and code 
source for the barcode.

Note that for those barcodes for which a nominal size recommendation exists, the size of the region 
created for a barcode may be overridden to ensure that the barcode is printed at the nominal size. (See 
the barcode editor dialog box for details.



Adding an index field for a new record

Click on the menuitem labelled ADD INDEX. The index editor dialog box appears, showing the title 
dIndex - Index field. The edit area is initially empty. 

Type in an index entry. At the end of each line of the entry press the <enter> key in    order to start a new 
line. 

Check that the entry is as you require.

Now click on OK. If you are not using a mouse you can press the <Tab> key to move the highlight to the 
OK button, and then press either the <enter> key or <space> bar.

The Editor block window empties. Actually it is waiting for you to type in another entry. If no more records 
are to be entered, click on the CANCEL button or press the <escape> key.



Adding an index field or printing a form from another application

dIndex offers the facilities to both add the clipboard contents to the current database and to 
print a form/label using the current style with the clipboard contents as the address. These 
facilities are particularly useful for importing addresses and printing labels when letters are 
being created using other windows applications - such as Word for Windows.

To add an index field to the current database minimise dIndex to an icon, then select the 
text which will form the new index field from the other application's window and copy it to 
the clipboard (in most cases this may be accomplished by clicking on COPY in the other 
application's EDIT menu).

Now hold down the <shift> key and double click on dIndex's icon. A message box will 
appear advising you that the clipboard contents has been added to the current address list. 
The message box may be cleared by pushing its OK button or pressing the <enter> key.

To both add an index field to the current database and print a form/label using the current 
style, minimise dIndex to an icon, then select the text which will form the new address from 
the other application's window and copy it to the clipboard. 

Now hold down the <ctrl> key and double click on dIndex's icon. dIndex's Print dialog box 
will appear for confirmation that you wish to print. All the facilities of the dialog box are 
available - so multiple copies or other records may be printed if required.

Note that if the clipboard does not contain text then the double-clicking on dIndex's icon will 
restore the dIndex window.



Adding a new record

Click on the menuitem labelled ADD RECORD. The Index editor dialog box appears, showing the title 
dIndex - Index field. The edit area is initially empty. 

Type in an index entry. At the end of each line of the entry press the <enter> key in    order to start a new 
line. 

Check that the entry is as you require.

Now click on OK. If you are not using a mouse you can press the <Tab> key to move the highlight to the 
OK button, and then press either the <enter> key or <space> bar.

The Index editor dialog is replaced by the Field block editor, showing the name of the first field for the 
current database style, and an empty edit area.

Type in the entry for the field, and then push the NEXT button if you wish to enter data for further fields, or
the OK button if you have entered all the data you require for that record. 

If OK is pushed, or if NEXT is pushed when all the fields for the record have been provided, the Field 
block editor closes and the Index editor reappears, ready for the entry of an index field for a new record. If
no more records are to be entered, click on the CANCEL button or press the <escape> key.



Adding a text block

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select TEXT BLOCK
from this menu by clicking on it.

The menu disappears and the mouse cursor changes to a top left-hand corner. Now move the mouse 
cursor to the point on the form at which you wish the top left hand corner of the text block to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right. A box is drawn on the form, representing the region which will hold the text block. The size of the
text block region you draw is of no importance as it will be resized when you enter text.

Release the left mouse button.

The text block editor dialog box appears, showing the title dIndex - Text block.    The edit area is initially 
empty. 

Type in some text. At the end of each line of the text press the <enter> key in    order to start a new line. 

Check that the text is as you require.    Now click on OK.

The editor dialog box disappears and the form image is redrawn and incorporates the added item.

Note that if the Snap to grid facility is on, then the box drawn with the corner cursor will appear only at 
sizes which are multiples of the grid size. 



Adding a Checkbox

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select CHECKBOX 
from this menu by clicking on it.

The menu disappears and the mouse cursor changes to a top left-hand corner. Now move the mouse 
cursor to the point on the form at which you wish the top left hand corner of the text block to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right. A box is drawn on the form, representing the region which will hold the text block. The size of the
text block region you draw is of no importance as it will be resized when you enter text.

Release the left mouse button.

The text block editor dialog box appears, showing the title dIndex - Text block.    The edit area is initially 
empty. When you enter some text this will be positioned alongside the checkbox you are creating. The 
text area may be left blank.

Type in some text. At the end of each line of the text press the <enter> key in    order to start a new line. 

Check that the text is as you require.    Now click on OK.

The editor dialog box disappears and the checkbox dialog appears, showing a number of groups of 
radiobuttons which may be selected to specify the format of the check box.

Check that the format is as you require, then push the OK button.

The dialog box disappears and the form image is redrawn and incorporates the added item.

Note that if the Snap to grid facility is on, then the box drawn with the corner cursor will appear only at 
sizes which are multiples of the grid size. 



Adding a date block

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select DATE from 
this menu by clicking on it.

Proceed as for adding a text block. 

A date block differs from a text block only in that the ^ symbol within a date block is translated into the 
current replacement date at the time that the block is displayed or printed.

Note that the format used for the date is that specified in the Windows control panel.



Adding a field block

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select FIELD 
BLOCK from this menu by clicking on it.

The menu disappears and the mouse cursor changes to a top left-hand corner. Now move the mouse 
cursor to the point on the form at which you wish the top left hand corner of the text block to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right. A box is drawn on the form, representing the region which will hold the text block. The size of the
text block region you draw is of no importance as it will be resized when you enter text.

Release the left mouse button.

The Field block format dialog box appears, showing an empty edit box into which the NAME of the new 
field may be entered.

The dialog also contain one series of radio buttons which allow the source of data for the field to be 
selected, and one series which allows for the formatting of data within the space allocated for the field on 
the current form. 

Check that items are as you require.    Now click on OK.

The dialog box disappears and the form image is redrawn and incorporates the added item.

Note that if the Snap to grid facility is on, then the box drawn with the corner cursor will appear only at 
sizes which are multiples of the grid size. 



Adding a sequence block

Click on EDIT and then select ADD ELEMENT from the menu. A sub-menu appears. Select SEQUENCE 
from this menu by clicking on it.

The menu disappears and the mouse cursor changes to a top left-hand corner. Now move the mouse 
cursor to the point on the form at which you wish the top left hand corner of the text block to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right. A box is drawn on the form, representing the region which will hold the text block. The size of the
text block region you draw is of no importance as it will be resized when you enter text.

Release the left mouse button.

The Sequence labelling dialog box appears, showing the current initial sequence number and any 
sequence prefix. 

Select whichever item you wish to modify and type in the new value or prefix text. 

Check that both items are as you require.    Now click on OK.

The dialog box disappears and the form image is redrawn and incorporates the added item.

Note that if the Snap to grid facility is on, then the box drawn with the corner cursor will appear only at 
sizes which are multiples of the grid size. 



Adding graphic elements

To add graphic elements (lines, boxes or pictures), click on EDIT, select ADD ELEMENT from the menu, 
and then select BOX, PICTURE, HLINE or VLINE from the list of elements to add a box, picture, 
horizontal or vertical line respectively.

Move the mouse pointer to the point on the form at which you wish the top left hand corner of the element
to appear. 

Hold down the left mouse button and while keeping the button down, drag the mouse pointer down and to
the right to create a box (or line) to represent the region which will hold the element. 

The size of the box you create will be the size of the element as it appears on the form. (You can, of 
course, modify this size later on.)

Release the left mouse button.

Note that if the Snap to grid facility is on, then the box drawn with the corner cursor will appear only at 
sizes which are multiples of the grid size. 

A selected picture element may be filled by Pasting a graphics image from the clipboard 
(using the PASTE PICTURE element of the EDIT menu), or by importing a picture from a file 
using the EDIT SELECTION item of the EDIT menu.



Batch printing

(Professional Plus version only)

Batch printing is the printing of a specified number of specified records, where the specifications are 
provided by a file of Batch commands.

A batch command has the form:

number of copies <space> identifying string

The number of copies is a numerical value (between 1 and 16,000) which determines the number of 
copies of the specified record to be printed.

The identifying string is a string which is searched for when dIndex attempts to locate the record required 
for printing. It must be unique within the database, and was originally intended to be formed from a code.

Batch commands may be combined into a list using the Batch Editor dialog, from which lists may be 
saved into Batch files. Batch files may also be created using a text editor provided that the batch 
commands in the above format are entered on separate lines of the files and in standard ASCII format.

The Batch Editor may be invoked by selecting Batch Editor from the FILE menu.

Batch printing may be initiated by selecting Batch Print from the FILE menu.



Resizing an element

To resize an element, first select the element (eg. by double clicking on it), so that a dotted rectangle 
appears around it.

Now hold down a <Shift> key and then hold down the left mouse button and drag the lower right-hand 
corner of the rectangle around the screen. The rectangle size and shape will change as the lower right-
hand corner follows the movement of the cursor, and may be positioned anywhere below and to the right 
of the elements upper left-hand corner. Release the mouse button and the element is redraw at the new 
size. 

For Picture elements, resizing may retain the original picture's aspect ratio. While resizing, hold down the 
<Ctrl> key before releasing the mouse button. The width of the element will be adjusted to retain the 
aspect ratio of the picture originally pasted into the element. Alternatively, hold down the <Alt> key before 
releasing the mouse button. The height of the element will be adjusted to retain the aspect ratio of the 
picture.

Note that while it is necessary for the mouse pointer to be on the element when you wish to select the 
element by double clicking, it is not necessary for the pointer to be on the element while you drag its 
corner position around.

Note that if the Snap to grid facility is on, then the dragged rectangle will appear only at sizes which are 
multiples of the grid size. 



Moving an element

To move an element, first select the element (eg. by double clicking on it), so that a dotted rectangle 
appears around it.

Now hold down the left mouse button and drag the rectangle around the screen. A solid copy of the dotted
rectangle will follow the movement and may be positioned anywhere on dIndex's window. Release the 
mouse button and the element is relocated. 

Note that while it is necessary for the mouse pointer to be on the element when you wish to select the 
element by double clicking, it is not necessary for the pointer to be on the element while you drag its 
position around.

Note that if the Snap to grid facility is on, then the dragged rectangle will appear only at positions which 
are multiples of the grid size. 



Changing page

The page number of the current page is shown as the last item in the menu bar before HELP (Page#). 

Clicking on the page # will cause dIndex to cycle through the pages of the current form style.

Alternatively the next, previous, first or last page may be selected using the appropriate item of the 
DISPLAY menu.



Using images for field blocks

A field may contain a graphics image. The image may be stored in a disk file in Bitmap (BMP), device 
independent bitmap (DIB), Paintbrush (PCX), TIFF (TIF) or metafile (WMF) format, or may be a standard 
clipboard format (CLP) file.

Image files may be selected by pushing the IMAGE button in the field block editor. The standard File 
Open dialog appears, allowing the user to chose a file in the current directory, or to changes drive or 
directory. The filetype may be selected from the combobox at the bottom of the files listbox.

Image files must be stored in the same directory as the current database (DLX) file.

If the user wishes to replace an image with a textual entry, this may be achieved by over-typing the image
file name in the field block editor instead of pushing the IMAGE button.



Importing a picture or bitmap for picture elements

A picture element may contain a graphics image imported from a disk file in Bitmap (BMP), device 
independent bitmap (DIB), Paintbrush (PCX), TIFF (TIF) or metafile (WMF) format, or a standard 
clipboard format (CLP) file.

To import select the picture field and then choose EDIT SELECTION from the EDIT menu.
The standard File Open dialog appears, allowing the user to chose a file in the current directory, or to 
changes drive or directory. The filetype may be selected from the combobox at the bottom of the files 
listbox.

Importing into an element which already contains an image will result in the previous content of the 
element being discarded.



Changing an element's font

The font used for any block containing text may be set independently, by first selecting an element by 
double clicking on it and then clicking on OPTIONS and then selecting Selection font item from the menu. 

For the specific case of the field blocks, the field font may be selected directly from the menu (ie. without 
having previously selected a field block). 

In either case the Font selection dialog box appears, labelled in the title bar with the element type. This 
presents the user with details of the current font, style and line spacing, and permits the user to change 
these properties. 



Defining and Editing Key strings

To define new key strings or edit existing key strings select KEY STRINGS from the OPTIONS menu.

The Key strings editor dialog box will appear showing a listbox containing the existing key strings, and an 
edit box which may be used to change existing key strings or enter new ones.

Use the list box and the edit box to make the changes required.

Click on OK and the dialog is closed and the newly defined key strings are available for use.



Exiting

To exit from dIndex select EXIT from the FILE menu

To close all open applications and exit from Windows select EXIT WINDOWS from the FILE menu.



Finding a string

To find an record which contains a specified string of characters choose SEARCH from the SELECT 
menu.



Changing displays

Forms may be viewed either at their actual size (Printer), maximized    (Maximise) , or reduced so that a 
whole printer page fits on the screen (PageView).

When each image contains many elements, the time taken to redraw the screen can by excessive. For 
normal editing, searching, organising and checking operations it is not normally necessary for all the 
picture and text block elements to be drawn on the screen image of every form.

Pictures (with HIDE PICTURES), text blocks (with HIDE TEXT BLOCKS), or all fixed elements (with HIDE
ALL) may be hidden on the screen display by selecting the relevant choice from the DISPLAY menu.    All 
elements may be made visible with SHOW ALL



Viewing marked addresses

When moving around database images the addresses displayed may be limited to those which have been
marked by turning on the SHOW MARKED ONLY menuitem of the DISPLAY menu.



Moving around databases

To change from one record image to another the following operations may be used:

For the next image:    select NEXT from the select menu; or press the <Page Down> key, or click on the 
Form# in the menu bar using the left mouse button.

For the previous image:    select PREVIOUS from the select menu; or press the <Page Up> key, or click 
on the Form# in the menu bar using the left mouse button while holding down the <shift> key.

For the first image in the database:    select FIRST from the select menu; or press the <Page Up> key 
while holding down the <Ctrl> key.

For the last image in the database:    select LAST from the select menu; or press the <Page Down> key 
while holding down the <Ctrl> key.



Selecting elements with the keyboard

Elements may be selected using the keyboard via the SELECT menu. Pressing <Alt>S followed by the 
underlined key in the name of the element required will cause the first element of that name to be 
selected.

Repeating the operation will cause the next element of the same type to be selected, and so on.

If the operation is carried out when there are no further elements of the required type, no selection will be 
made, and any existing selection will be cancelled.

Choosing SELECT AGAIN or pressing <F10> causes the last item which was selected to be selected 
again.



Date Fields

The ^ symbol in field blocks is translated into the current replacement date before displaying or printing 
ONLY IF THE ^ SYMBOL IS THE FIRST CHARACTER IN THE FIELD. The current replacement date 
defaults to the current date, but may be changed within the Replacement date dialog, invoked by 
selecting Set ^ to date from the OPTIONS menu.

Advanced dates (ie. dates a set number of days in advance of the replacement date) may also be 
specified by following the ^ symbol immediately by a plus sign and a numerical value in the range 0 - 
1024. eg. ^+7

Advance dates are particularly useful for creating "sell by" and "best before" labels, or for printing expiry 
dates on database printouts.



Context Sensitive Topics

dIndex's Help system includes topics that you can call directly from dIndex. 

Context-sensitive Help is provided automatically whenever a HELP button is pushed with a dIndex dialog 
box.

To get Help on a specific command in dIndex, highlight the dIndex menu command using the keyboard 
and press F1 to get help on the command.

Context-sensitive help is also available by pressing the <Shift> and <F1> keys simultaneously. The cursor
changes to the help cursor. Clicking on a menu item or main window border area will produce help on the 
relevant subject.



Congratulations!

You have found a topic that we missed in creating the help files!

Please let us know which topic we missed



Eureka!

You found a topic that is accessible from a keyword search only. Unfortunately we forgot to include this 
topic in the help files.

Please let us know which topic we missed





Windows Keys

Choose from the following list to review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.



Edit Window

An edit window is a window which allows the user to enter text from the keyboard and edit 
text using the editing keys, such as backspace and delete.



Maximize Icon

You have clicked on the Maximize icon. 

Normally the effects of clicking on this icon will depend on the size of the application's 
current window. 

If the window does not occupy the entire screen, clicking on maximise with the mouse 
pointer will make the application window expand to fill the whole screen.

If the window already occupies the entire screen, clicking on maximise will make the 
application window return to the size it occupied before it was maximised.



Minimize Icon

You have clicked on the Minimize icon. 

Normally clicking on this icon with the mouse pointer will reduce the application's window to 
the application's icon, which will be displayed at the bottom left-hand corner of the screen 
icon.

The application's window can be returned to its previous size by double clicking on the 
application's icon.



Sizing Border

You have clicked on the Sizing Border.

Normally the sizing border is used for changing the size of an application's window. 

To resize a window move the mouse pointer to the sizing border (the cursor changes shape 
when it is over the sizing border), hold down the left mouse button and move the cursor so 
that the window outline occupies the area you require.    

Release the mouse button and the application's window will be redrawn to occupy the new 
area.

Selecting a corner of the resizing border allows resizing in both dimensions simultaneously.



System Menu

You have clicked on the System Menu Box.

Normally clicking on the System menu box with the mouse pointer will display a system 
menu which contains commands such as 

Restore
Move
Size
Minimise
Maximise
Close
Switch to...

These commands have the following functions:

Restore: Restore is only available when the application's window is 
minimised (ie. is shown as a icon at the bottom of the screen). 
Clicking on Restore restores the window to its previous size.

Move: Once selected the window may be moved on the display screen 
using the cursor keys. Press <enter> or <Esc> to terminate the
move.

Size: Once selected the window size may be changed on the display 
screen using the cursor keys. Press <enter> or <Esc> to 
terminate resizing.

Minimise: Once selected the window appears as an icon at the bottom of 
the display screen. An icon can be restored to its previous 
displayed window size by clicking on the icon and using the 
resulting system menu, or by double clicking on the icon.

Maximise: Once selected the window size is increased to cover the entire 
display screen.

Close: Once selected the application will terminate. 
Switch to...: Permits switching to other Windows via the Task List. 



Title Bar

You have clicked on an application's Title Bar.

Normally an application's title bar display the name of the application, and in some cases 
additional information about the application.

The title bar may also be used to move the application's window around the screen (unless 
the application's window is already maximized.

To move the applications window move the mouse pointer into the title bar, hold down the 
left mouse button, and move the outline of application's window to the new poision you wish
it to occupy. 

Release the mouse button and the application's window is redrawn in its new location.





Clipboard

A temporary storage area for cut or copied text or graphics. Text contents of the clipboard may be pasted 
into text blocks of the dLSoft applications, while bitmap or metafile images may be pasted into picture 
blocks.



Select

Selection is the process of identifying an element of screen image by double clicking on it.    When 
selected an element is surrounded by a dotted rectangle. 

To cancel the selection of an element click once on a empty part of the window.

To select text in an edit box, drag the cursor over the required text while holding down the <shift> key. 
Selected text is shown as highlighted.

To cancel a selection of text in an edit box click once in an unselected area.



Double click

Double clicking on an item displayed in a window is the act of moving the mouse pointer so that it is over 
the item and then pressing and releasing the left mouse button twice in rapid succession.

To be recognised as a double click the time interval between the two pressings of the mouse button must 
smaller than a threshold value defined within Windows. This value may be changed within the Windows 
Control Panel.



Click

Clicking on an item displayed in a window is the act of moving the mouse pointer so that it is over the item
and then pressing and releasing the left mouse button.



Keystring

A Key String is a string of up to 254 characters which may be selected from the key string listbox and 
pasted into the text displayed in the dIndex text or field block editors.

Key strings may contain several lines and are saved as part of the form's style sheet.



Mark

Marking is the process of identifying a record as "Marked". Marked items may be selectively displayed, 
printed or copied to a file or the clipboard.

Records may be marked through the Mark dialog box, or by clicking on the record number while holding 
down the <Ctrl> key.



Drag

Dragging is the process of moving the mouse pointer while holding down the left mouse button. At the end
of the drag the mouse button should be released.

A selected element may be dragged from one part of the displayed image to another to move the 
element.



Text block

A text block is a block of text which appears in the same position on every form image.

Text blocks may contain up to 254 characters.



Date block

A date block is treated in the same way as any other text block except that the ^ symbol is translated into 
the Replacement date at the time of printing.

A date block appears in the same position on every form image.



Sequence label block

A sequence label block is a single line block of text which may contain a constant prefix followed by a 
number which is incremented for each member of the current database.

A sequence label block appears in the same position on every form image.



Picture block

A picture block    is a fixed size area of the form image which may contain a picture copied in from a style 
sheet or the clipboard. Pictures may be bitmaps or metafiles, and will be adjusted to fit in the area defined
by the user.

A picture block appears in the same position on every form image.



Box

A box is a rectangle drawn on the form image at a position specified by the user. 

The thickness of the lines used to created the block may be specified for any selected box by choosing 
BOX LINES from the OPTIONS menu.



Snapping

Snapping is the process in which any elements which are created or selected, moved or resized, will have
their corners moved to the nearest point on an imaginary screen grid where vertical and horizontal lines 
intersect.

The Snap setting dialog permits the user to define the line spacing of the invisible grid, and to turn the 
snap facility on or off.



Vertical line

A vertical line is a line drawn vertically on the form image at a position specified by the user. 

The thickness of the line used may be specified for any selected line by choosing LINE SIZE from the 
OPTIONS menu.



Horizontal line

A horizontal line is a line drawn horizontally on the form image at a position specified by the user. 

The thickness of the line used may be specified for any selected line by choosing LINE SIZE from the 
OPTIONS menu.



Index block

An index block is present on every record (although it may be moved outside the printed page area if 
required) and contains the primary text which varies from one record to the next.

dIndex allows additional index blocks to be created on any page of a form, and such additional index 
blocks may have their fonts, etc. specified separately in the same way as any other text block. However, 
such additional index blocks will always contain the same text as the primary index block.



Field block

A field block is an area of a form which may contain text which varies from one record to the next.

All field block contents are printed using the same font (the field font) unless the font for a specific field is 
explicitly changed.

Field blocks may be named so that they can be readily identified, but the contents of each field block is 
filled in sequence either from the key board or from fields of address list files. The order in which field 
blocks are filled may be changed by choosing REORDER FIELD BLOCKS from the OPTIONS menu.

Field block names may be specified when the block is created. The name of a selected field block may be
changed by selecting EDIT SELECTION from the EDIT menu.

Field block contents may be duplicated or hidden (using the Field block dialog).



Checkbox

A checkbox is a square box positioned alongside text, and is designed as a target area for manual 
marking on a printed form.

The size of a selected checkbox and its position relative to its associated text may be spcified by 
choosing FORMAT SELECTION from the EDIT menu.



Grid

A grid is a rectangular pattern of vertical and horizontal lines, which may be used to separated other 
elements or to provide areas for manual entries on printed forms.

The number of vertical and horizontal lines in a grid does not include any side lines or top and bottom 
lines, and may be changed by choosing EDIT SELECTION from the EDIT menu.

By default grids are fully enclosed (ie. they have sides and a top and bottom line). However the outer lines
of a selected grid may be removed by turning off the bounding box with the BOX LINES item of the 
OPTIONS menu.



Barcode block

A barcode block is a region of a page into which a barcode will be placed.

Barcodes consist of a coded sequence of black and white lines of varying thickness. Barcodes may be 
created from data supplied through the barcode editor dialog, and may be encoded using a variety of 
standard algorithms.

Note that barcode print quality is printer dependent.



 


